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1 Introduction 

Nowadays more and more users connect to the Net in order to receive audio or video stream in live. More and more applications are based on the streaming process, for example video conference (Net Meeting), live radio (Shoutcast Winamp), live TV (Real Audio) , etc.

The problem today is that we can’t listen radio or watch TV efficiently on the Net because it requires too much resources. Well, live streaming is certainly the future of Internet.

Many very important enterprises are investing in order to create such applications. 

We can for example mention Andersen Consulting which has a department that searches and 

develops such kind of applications. All this shows that live streaming is the present and the future of 

Internet. 

The final goal of our project is to develop an application which will allow people to receive different kind of  documents in live. Three weeks are of course too short to achieve this ambitious project. This is why our main goal was to create a service were clients would be able to receive documents that are stored in a Server. 

2 General Presentation

2.1 Getting started with our software

Our project is to develop an client-server application for transferring documents. Among the objectives are :

· using the least amount of LAN or Internet bandwidth (via Multicast UDP) : transferring the 

same document to multiple clients at the same time, but only one copy leaves the server.

· Reusability (of the code)

· Interoperability

· Compatibility with Internet standards

· General notion of “Document” : text file, messages, word document, sound file, etc.

But before going any further we need firstly to define what  TCP, a UDP and MULTICAST stands for.

2.2 Technology Context

These days, what are called “unicast technologies” represent 90 % of the Internet Use. But these technologies are not applicable for example in TV broadcasting on Internet, one of the future probable evolutions. Why ? Because unicast technologies require too much bandwidth at the server-side to send the same document to a million of clients. So in the near future, multicast technologies could play an important role in the Internet world. 

We will try to explain that in this presentation of the different kinds of networking technologies available. 

2.2.1 Unicast Technologies

An Unicast technology is very simple to understand : when a client wants a document, the server sends to him a copy of the document.  But it has to send n copies of a document to deliver the same to n clients. 

So imagine, you’re a big website like Yahoo.com, the server need to deliver one copy of the main page each time a Internet user accesses the website. And that represents a million of copies in a hour : that requires a very large bandwidth !

There is a lot of unicast technologies. Some well known examples are HTTP (world wide web), SMTP (email transport), NFS (network file sharing). Some of them are reliable (TCP type), some are not (UDP type).  

· Strenghs :

· Secure : any lost information is re-sent (for TCP)

· lot of Internet applications use this technology

· Cons :

· Not scalable (lot of bandwidth required)

· Not applicable to exchange large multimedia files
2.2.2 Traditional UDP Multicast

This technology is faster because only 1 copy of a document is needed to be sent out by the server to deliver n clients.

But it is still unused today because it requires some new hardware installation to be used on the Internet. So for now, we can’t deploy any networking software that uses Multicast technologies and, at the same time, is planned to be use on the Internet. But network hardware installed for a local area network allow multicast to work inside a local area network. 

There is also the problem that UDP Multicast is not  reliable : it is not designed to do some errors checking. So if a packet is lost, there is no native mechanism to ask the ender to re-send any lost packet.

· Strengths :

· Faster

· Scalable : infinite number of clients possible

· Cons : 

· Not secure : server send information only once
· Clients are not sure to receive the complete information
· Not applicable for an Internet size network (for the moment).

2.2.3 Reliable Multicast Technologies

Reliable Multicast Technologies are designed to provided some error checking services over traditional multicast protocols. A lot of research have been made to provide the “best” reliable technology but most of them uses the same concept :

If a packet is lost, the receiver ask the sender to resent any lost packet. It is an Not-Acknowledgement signal (NACK)  or an Acknowledgement Signal (ACK).

Among those reliable technologies, we can cite :

· Multicast Transport protocol (MTP-2)

· Xpress Transport protocol (XTP)

· Reliable Multicast Protocol (RMP) , etc.

Each of them have their strengths and their weaknesses. 

2.2.4 Our choice for Multicast protocol : FCAST

Among the reliable multicast protocols we‘ve discovered, we found one that seems to fit best in our application : an scalable and reliable multicast protocol specially designed for file transfers.


Its name is FCAST for “file multicasting”.

This protocol was born in the Microsoft Bay Area Research Labs. We can use primitive functions available via an ActiveX  provided by Microsoft. 

Details of the protocols are a little bit too complex too explain but, here is how it works :In previous reliable multicast protocols, receivers send NACK or ACK signals when they have lost some packets. Instead of that, in Fcast, the sender sends multiple copies of the document over a multicast port. And when receivers have lost some packets, they just wait for the next arriving of the document to complete the reception.

This model is very scalable, because it is completely independent from the number of clients. Statistics have been made and the average number of copies needed to be sent is around 2.5 times.  And this amount of bytes is the same for 10 receivers, or 100 receivers, or 1 000 000 receivers !

2.2.5 Recapitulatory

This table shows the protocols we’ve presented previously and make an comparison of how many copies have to be made by the server to send the same document to some receivers.


As you can see, TCP and UDP protocols are not a solution for us because the server sends too much copies. UDP Multicast (traditionnal multicast) is not good for us because it does not handle some error checking. MTP-2 and other reliable multicast protocols using the same concept, are not as scalable as Fcast. So this is why we chose Fcast as our document transferring protocol.

2.3 Features and commands

2.3.1 Administration Commands

The administrator of the Server must be able to do some operations that the client is not allowed to do. Furthermore the administrator must be able to do the Client’s allowed operations.
· groups & user management

· List connected / not connected users

· Delete user account

· Ban, kick user 

· server management 

· Shutdown

· modify documents’ list

· change documents priority

· remove documents

· insert documents

2.3.2 Client Commands

The Client must be able to do:

· List queued documents
· upload document on server

· When to send document : send it now, later or just store


· Meta information

· File information (Login, description, format …)

· identification (Login, Pass, IP)

· Join a group (automatically receive group’s data)

· Retrieve documents’ list
· Statistics Ping and Whois


3 User Manual

3.1 Notes  

This is our first release. There are still some improvements to be done but the can already use this program.

3.2 Requirements

Windows 32 bits platform (Windows 95, 98, Me, NT, 2000).

Local Area Network.

3.3 Get Started with the server

General presentation :


Configuration steps :

The server’s configuration is loaded from the INI file located  in the current working directory (i.e. the directory where the program is located). Do not modify the INI file with an external editor.

1. Before running a server you have to choose :

· The TCP Port where clients have to connect. (Your clients will have to specify the same TCP port). 

· The Multicast IP and Multicast Port on which Multicast data will be sent. This IP is a special IP, see below for information on Multicast.

· The Multicast Port, they will get the current playlist or other information.

· The Document Database location : the server’s file where all information about files are stored.

· The Users Database location : the server’s file where all information about registered users are stored.

· The Document Path : the directory where files are stored.

· Fcast Configuration for sending files to clients : You have to enter another a Multicast IP and a port different than the previously chosen. You must also specify the round (the number of times a file will be sent) and rate values (the data rate of the Fcast streaming). For more information about this values, see the Fcast documentation. It is recommended to keep the default values.

2. Save configuration :

If you click on the Save Parameters button [image: image7.png]Save Parameters



, the configuration is automatically saved in the INI file.

3. Start the server :

To start the server you just need  to click on the start button [image: image8.png]


.

Once the server is started, clients can connect to your server and receive files.

You can see all users actions in the Log box.

You have to set up a playlist : a list of files to be sent to clients.

The playlist and other administration tools are presented in the « Server Online tools » section.

4. Stop Server :

To stop the server you just have to click on the stop button [image: image9.png]Stop Server



.All users status will be set to Offline in the database, the databases will be saved.

All the connections will be closed : no more data will be sent and no client connection will be accepted.

Server Online tools :

Users manager:


You can add and delete users but also modify user’s information in the server database when the server is running.

In the left listbox you can see the users connected to your server and retrieve some information (in the right part of the window)by clicking on their login. You can modify these information and save them by clicking on the Apply Changes button. Note : the Banned option, if selected prevent the user to open a connection.

In the right listbox you can see the offline users and do the same operations as with the online users.

You can delete an account by clicking on an user login and clicking on Delete User.

You can add a user by entering values in the text boxes and clicking on Add User. 

Notes : 
Users can register with the client program.

The users database is stored in the server. 

Documents manager:


This is an interface for the document database, you can see all the registered documents and modify some properties.

The Add button opens a new window :


In this new dialog box you can choose a file located in the server by clicking on the browse [image: image10.png]


 button.

After that you must enter a description of your file in the description text field.

You can select the Persistent option (the file won’t be deleted after been sent to clients) and select the Streamable option (the software associated with the file type will automatically be launched as the file transfer begins).

Playlist manager:


The playlist represents the order in which document have to be sent to clients.

You can locally manage it, by adding, moving document into the list.

Adding a document :

Click on the browse button [image: image11.png]


 at the bottom of the window (it will open the documents manager), and select a file in the document manager, then click OK. After closing the document manager window, click on the Enqueue button below the selected document description.
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Changing a document position in the playlist  :

You can change the document position in the playlist by using the up and down buttons :

Select a document in the play list and click on:

· Up if you want to put it upper in the playlist.

· Down otherwise.

Removing a document from the playlist :

Select a document in the playlist and click on the delete button.
3.4 Get Started with the client 

General presentation :
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Configuration steps :

1. Before running the client :
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Open the Server Menu and select Properties. A new dialog opens. 

You must fill correctly all the fields conforming to the server parameters. Server IP is the server IP address for TCP connection, Parameters port is the server TCP port to connect  and Group Name and Data Port are the Server Multicast group parameters. No FCast configuration needed, FCast parameters are sent via Multicast after the login procedure.
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Note: If you want to save these parameters, open the File Menu and select “Save Parameters”.

2. Connect to the server :

Now you are ready to connect.

Click on the Connect button [image: image16.bmp].
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A new dialog box appears. If you already have an account, select Existing User and enter your login and password. Then click OK to connect to the server.

If are not already registered you can create an account:

Select New User, and fill all the text fields with your personal information. If your login is not already registered, you will be connected with the login you created and your account will be saved in the database.

Otherwise, you’ll see a LOGOUT message in the Log Box and you’ll need to choose another login. 

You’re now connected and you’ll receive the files sent by the server.

You can use some tools integrated in the client to get some infos, see the “Clients Online Tools”

3. Disconnect:

To disconnect, just click on the disconnect button [image: image18.png]


  or go in the Server menu and choose “Disconnect”.

Note: The connection will be also closed if you close the client application.

Clients Online Tools

Upload (not implemented in this release):
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You can upload files to server : they will be stored on the server and added to the server playlist. You just have to select a file using the browse  [image: image20.png]


  button and enter a description in the description box. After that, just click send to upload the file. (this feature is not functional in this release).

File Association :
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Select the Options menu, the “File Associations”. A new dialog box appears. In this dialog you can specify which program to use to open a received file. If a received file is associated with a program it will be opened with this program, otherwise with the Windows associated program (using your Windows configuration).

You can specify new associations by entering a new extension in the Ext. text box and choose a program by using the browse button [image: image22.png]


 .

To remove an association, just select it and click on delete button.

Download Directory :
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You can specify the download directory for the received files : open the Options menu, select Folders. A new dialog box appears. Click on the browse button [image: image24.png]


 and select a directory.

If you want this parameter to be saved for next sessions, open the file menu and select “Save  Parameters”.

Whois and Fileinfo commands:
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You can get information about a file by selecting it on the playlist (just click on it) and then clicking on the FileInfos button. Information about this file will appear in the Infos box.

You can also get information about a file owner by clicking on the file and then clicking on the Whois button, Information about the owner will be displayed in the Infos Box.

Custom Command (not recommended, only for Experts):
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You can send a custom command to the server :

When you are connected, click on the “Send Comm.”. Enter a new command string in the new dialog box and click on send. You’ll see the results in the Log box.

4 Architecture

4.1 Client / Server  Connection and Communication

4.1.1 Global Architecture

Here is a graphical representation of the architecture :


As you can see, Clients and Server communicate via a TCP connection, the Server uses also a UDP multicast communication for global commands (update of the playlist, notification of shutdown…). 

Furthermore we have Fcast, using a multicast UDP communication, that sends the stream to the 

Clients.

Administrators can communicate with the server in two ways :

· a special Client application that has some features that are disabled in standard clients.

· directly on the server via the Graphical User Interface.


Ports/Sockets opened by each parties :

Server
Client

- 1 TCP port to exchange commands

- 1 UDP Multicast port to send global commands

- 1 or more UDP Multicast port for FCast
- 1 UDP Multicast port to receive global commands

- 1 TCP port to send / receive commands

- 1 or more UDP Multicast port for FCast

4.2 Server Architecture

4.2.1 Global server architecture 


4.2.2 Server Graphic User Interface

Our Graphical User Interface use the  Micrososft Fondation Classes (MFC) and is written under Visual 

C++. Here is how the Server GUI is architectured :


4.2.2.1 Server Event Listener Implementation

When a modification appear in the User Database (ex : an new user is online), we have to inform the GUI to refresh its Online Users list. To accomplish that, we use an Event-Listener Design Pattern.

Here is the pseudo-code of the Update mechanism : 

Update( Event e) {


Switch( e.getMessage() ){



Case NEWUSER:




Update UsersOnlineListbox by adding(e.params[1])




Update UsersOfflineListbox by removing(e.params[1])



Case ...

}

}


4.3 Client architecture
The client doesn’t need any database or any kind of storage element. He receives and interpret commands and update his GUI. 


4.3.1 Client / Server Communication

Here is how communication between server and clients are made, the name wrote below are the 

Classes used in the Client-Server implementation

· Server side

The Server is  waiting for Clients  TCP Connection. When a Client requests a connection, the Server 

creates a thread in order to manage him. (1 thread for each client).

Furthermore, the Server sends data streams with an UDP Multicast port. In order to permit those 

operations the Server must create a thread.

· Client side

The Client creates a thread in order to communicate with the Server via a TCP Connection. An 

another thread is listening for UDP Multicast messages.


The TCP Thread of the Server is constantly waiting for commands. When he receives one, he interpret it, he send the result to the Client and he loop, back to the waiting process.

The TCP Thread of the Client is sending commands when the client is asking him to do so. After 

sending the command he waits for the answer.

The Multicast Thread of the Server is sending commands when it is necessary. These commands are sent to all the clients who are listening.  

The Multicast Thread of the Clients are listening for a command. When they receive one, they interpret 

it, and loop, back to the waiting process.

As we can see the Server needs to be able:

· To send, receive and interpret TCP commands

· To send MULTICAST commands

And the Client: 

· To send TCP commands

· To wait and interpret commands

In order to be able to accomplish all these tasks we need to define communication protocols.

4.3.2 Protocols

We externalize the parsing task from the connection task to be more flexible : we want to be able to change protocols without difficulty.

So we implemented an Object model for the Protocol. The Protocol class is an interface for protocols 

are created. And protocols are implemented from this interface.

So we first implemented a custom protocols for our client/Server application. But, we also planned to 

implement an SOAP protocol.


Note that, not only this class is responsible for parsing the request, but also it is responsible for 

extracting and sending packets from the socket.

In that way, if we want to change the way we are sending commands, no need to touch at the 

Client/Server implementation. We just need to add a new Protocol.

4.3.2.1 Iradis Protocol

· TCP communication

These are the operations allowed via the TCP connection: 

Request sent by the Client – TCP
Meaning
Response sent by the Server - TCP

LOGIN login passwd ip port
Connect the client
201 if the user is registered and not logged in
401 if the user isn’t registered or already logged in

LOGOUT login
Disconnect the client
202 if the logout request succeed

WHOIS login

Return the login, fist name, last name, his ip or last ip,  his status (online or offline), banned or not

403 If the user doesn’t exist

REGISTER login passwd name lastname ip port
Register the client
204 if the user isn’t already registered

404 if the user is registered

They are used in the TCP communication and are individual commands. When a user trying to connect to the server, he can or register and automaticly log his self ( if he is a new member) or login. If the authentification fails he is disconnected else he is ready to receive the audio stream and is allowed all the other operations described previously.

· TCP - MULTICAST communication

 When a user log his self he must receive the playlist. Automaticly when the login succeed, the client sends also a  PLAYLIST request by TCP. He receives by UDP MULTICAST the playlist. In that way the other clients are refreshing their playlist.

Request sent by the Client – TCP
Meaning
Response sent by the Server - MULTICAST

PLAYLIST
The client request the playlist.
PLAYLIST file1 owner1 file2 owner2 …

And these are the operations allowed via the MULTICAST communication:

Informations sent by the Server – MULTICAST
Meaning
Response 

PLAYLIST file1 owner1 file2 owner2 …
There’s a modification in the playlist of the server. We send the new playlist to the clients.
203


FCAST ip port
A Fcast communication will be established by this <ip> and in this <port>. This command is sent every time the server send a file by FCAST.
204

LOGOUT
Disconnect the client
202 

These operations are not send via the TCP connection because all the users online must be notified.

These are global commands. 

The LOGOUT operation is used when the the administrator wants to shutdown the server or wants to 

disconnect a whole group of clients. The other operations is notify all the listeners that something 

happened (DOCS, USERS) or will happen (FCAST).

For every type of communication if the command is not defined in the protocol then it returns 406 if 

there are not enough parameters it returns 405.

The default token is a space but you can choose with our implementation the token you want to use.

Furthermore adding commands in very easy, one of our most important goal is to be extensible.

5 Members and organization

There were six team members on this project : Nicolas Besson, Julien Canet, David Chungue, Nicolas Martin, Christophe Paris and Christos Toyas. The idea of this project did not come from the Essi but from us, so we were very motivated. Every member of the team tried to work on every part of the creation and conception process in order to learn as much as possible. We started with a basic version of the application and then we upgraded to the final release. 



6 Difficulties and benefits

During our project we encountered some problems. One of them was how to manage multiple connections and terminate properly the program . After many hours of searches for Microsoft documentation we found out how to solve the problem. 

Another problem was how to use Microsoft graphical libraries. Microsoft provides tools permitting to design applications. These tools are very difficult to use and few documented.

Despite these problems we acquired and increased our technological background. We are now able to develop professional windows network applications.

7 Conclusion

To conclude, all of the team was very happy with this project. We learned  many new technologies that will be widely used  in the future market. We also learned to work and think like a team.  With this project, we participated in the whole creation process of an application. In that way , we learned how to deliver a professional program including, an installer, a help support and finally an online documentation .

To finish we would like to thanks our supervisor, M. Jean-Yves Tigli, who was always present and ready to answer to our questions.

8 References

PRIVATE
MFC

PRIVATE
CodeGuru - Visual C++ http://www.codeguru.com/

Source Code for Visual C++, C#, .NET and Visual Basic Developers

CODESITES.COM  http://www.codesites.com/index.shtml

Lots of programming links 

CstringList http://msdn.microsoft.com/library/devprods/vs6/visualc/vcmfc/_mfc_cstringlist.htm

Microsoft Foundation Class Reference. Excerpt: CStringList The CStringList class supports lists of Cstring objects. All comparisons are done by value, meaning that the characters in the string are compared instead of the addresses of the strings.

DevCentral Learning Center  http://devcentral.iftech.com/Learning/tutorials/submfc.asp

This is a complete tutorial, you should check it out. This site also features a whole library of classes.

DIRECT ACCESS TO MFC in MSDN  http://msdn.microsoft.com/library/default.asp?PP=/library/toc/vcmfc/vcmfc0-1-0-208.xml&tocPath=vcmfc0-1-0-208


MFC Black Book - Table of Contents http://ccfit.nsu.ru/programming/MFC/MFCBlackBook/main.html

Black Book of MFC

Microsoft Visual C++ Home Page http://msdn.microsoft.com/visualc

Homepage for Microsoft Visual C++ 6.0 with product information, technical information, samples and downloads, developer community information and product news and reviews

MSDN Online Code Center http://msdn.microsoft.com/code

Sample Apps From Microsoft 

MSDN Online Search http://search.microsoft.com/us/dev/

MSDN Online Search


Special Edition Using Visual C++ 6 -- Table of Con http://nps.vnet.ee/ftp/Docs/C/Using Visual C++ 6/index.htm


The Code Project - Homepage - Free Source code and tutorials http://www.codeproject.com/ 

Free source code and tutorials for Windows developers. Programming help for Visual C++, Windows, MFC, C++, GUI, ASP, XML, UML, SOAP, ATL, VB, ADO, SQL, DCOM, COM, Windows DNA, CToolBar, CMenu, CdockBar, CButton, CEdit, CStatic, CListCtrl, CTreeCtrl, CtreeView, CListView, CListBox, CFrameWnd, CMDIFrameWnd, CStatusBar, CtabCtrl

Visual C++ Developers Journal http://www.vcdj.com/

This site is very helpfull to Visual C++ programmers. It has a lot insight articles

Visual C++ Tutorial – FunctionX http://www.functionx.com/visualc

This is our Visual C++/MFC tutorial. We explore different classes that are part of the MFC library.

Visual C++ tutorials for beginners http://www.1001tutorials.com/vcpp/index.shtml

Visual C++ tutorials for beginners. Each tutorial has been reviewed by the author. Get up to speed with Visual C++ with these free tutorials.

Visual C++ Unleashed http://developer.grup.com.tr/language/visualc/

www.mindcracker.com - C++ MFC ATL COM ... http://www.mindcracker.com/

 Free source code C++ VC++ MFC ATL COM DCOM COM+ Windows DNA .NET C# XML ADO DAO ODBC Samples Programming C 



PRIVATE
TCP Multicast Protocols

PRIVATE
Fcast Multicast File Transfer - Microsoft Bay Area http://research.microsoft.com/barc/mbone/fcast.htm

A very good protocol for file transfer

Reliable Multicast Protocols http://web.nps.navy.mil/~seanet/mcast/Final5.htm

Comparaison of the different TCP Multicast protocols that are used today

PRIVATE
ActiveX

PRIVATE
A good pdf file about COM http://methods.distance.cmu.edu/shared/lect/COM-1.pdf

Microsoft’s Component Object Model (COM™)

ActiveX Programming with Visual C++ http://cplus.h1.ru/cplus/activx/

COM/DCOM BenKhaldoun KAMEL http://perso.club-internet.fr/kamel/html/comdcom/

COM/DCOM under MFC

Connection Points http://msdn.microsoft.com/library/devprods/vs6/visualc/vccore/_core_connection_points.htm

MSDN Library - Visual Studio 6.0 Documentation - Visual C++ Documentation - Visual C++ Programmer's Guide. Excerpt: Connection Points Home This article explains how to implement connection points (formerly known as OLE connection points) using CCmdTarget and CConnectionPoint.

MFC Black Book - Table of Contents http://ccfit.nsu.ru/programming/MFC/MFCBlackBook/main.html

MFC black book – a very nice tutorial about MFC

DevelopingTheControl http://msdn.microsoft.com/msdn-online/workshop/components/activex/magic.asp

A four part paper on ActiveX control and DCOM sample which includes building the pusher client application, adding a connection point to the server, and developing the ActiveX control
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